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Ched in a nutshell

The functionality of the Chart Editor (Ched) can be divided into three different groups:

· Basic play editing functions

· Play simulation and creation of CAVE or VRML file

· Remote control of the CAVE

Basic play editing functions

The play is stored in a simple way.  Each player has a path, which is defined by control points.  Each control point stores the time, position, angle (viewing direction), a pose, and whether the player has the ball at this point of time.  That means each control point represents the state of a player at a certain time key frame.  All the values in-between are interpolated.

The system distinguishes between play information, player information, and control point information.  They all have separate menus.

A play can be created, loaded, and saved.  The user can change basic play properties, such as the name of the offense and defense team, the start time, the play duration, the ball position, whether the play is a passing play, and whether the play is successful for the offense team.

The user can easily navigate through the play.  He or she can move the play or zoom to a point of interest, such as a specific player or the whole play.

Player can be added or removed.  Every player has a couple of properties that can be changed like whether he is an offense or defense player, his number, and his position.  Once this information is entered, the user can define the path by just selecting the different key frames.  The time and position of each key frame can be changed by simply dragging the associated control point.  It is also possible, to determine all the times keys and angles automatically.

Once a play in entered, the user can start the animation (forward or backward), pause the animation, and skip to the beginning or the end of the animation.  This makes it easier to fine-tune the play.

It is also possible to change the general appearance.  The user can activate a yard or a foot grid and all the control points can be snapped to these grids.  Also, a representation of the field, the paths and the control point labels can be switched on or off.

Play simulation and creation of CAVE or VRML file

In order to create a CAVE animation or a VRML file, the play has to be preprocessed.  The game is divided into small time frames and the whole game is simulated.  Ched checks for each time step whether player come close and have to interact.  The AI selects the right animation depending on the current play situation, the position of the involved players, and whether or not he has the ball.  The user can always overwrite the AI.

Remote control of the CAVE

Ched can also be used to control the CAVE simulation from an external computer (laptop).  This is very intuitive for the user, because he or she knows already the graphical user interface.  All this functions are combined in one menu, since they only change the CAVE environment and have no effect on the play itself.

Many commands deal with making the 3D navigation easier.  The user can go to predefined viewpoints in the stadium or can easily navigate to a player.  There are four different modes, how a user can follow a player during a game.  Is it also possible, to switch between walk and fly mode.

Other commands change the presentation style.  It is possible to activate a ball marker or make the key player transparent.

Sounds events can be started or stopped, the stadium can be chosen, and a changed play can be transferred to the CAVE (update).  A play can be started (forward and backward) with different speeds and paused.

The functions in detail

The Ched window is divided into four different areas.  The main menu is in the uppermost area.  Directly below are the controls for the animation and various status fields.  The biggest area in the center is the main display area.  It shows the important information of the players, the paths, the field, and the ball. Most interactions will happen in this area.  The lowermost area is the time control area.

 The menu
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Ched’s menu has six submenus, which organize the different features in groups.  Each submenu will be explained in the next chapters.

The File menu
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The File menu collects more general features, which interface with the file system.

New deletes the current play and creates a new empty play.  It will open the Play - Option dialog, so that the user can choose the general play options from the very beginning.

Open… let the user load an existing play.  It will open up a file browser.  The user has to select a file and click on open.

Save will save the current play under the current name.

Save As… let the user save the current play under a new name.  It will open up a file browser.  The user can specify the new name and click on save.  The name of the play will change (the name shows up in the window title bar).

Save Translated As… let the user save the current play in a new format that is used for the CAVE or VRML.  Ched will start the game simulator and the AI will add information for players interactions.  If this two steps were successful, Ched will open up a file browser and the user can specify the save name and click on save.

Save VRML As… was intended to be used for an integrated VRML exporter.  The current situation is different.  The user has to save the play by using the function Save Translated As… and then invoke an external tool.

Quit will quit the program.  Changes will not be saved.

The Mode menu
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Ched has four different modes.  Please read the Main Display area chapter for more information.

The Player menu
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The Player menu groups all functions for changing the player information.  They work only on the current selected player.  It is necessary that the user first selects a player (e.g. by clicking on his path).

Edit will open up the player dialog box for the current player.  The user can choose, whether this player is an offense or a defense player, the number on his back, and his position.
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Center will center the Main Display area on the current player player.  The whole path will be visible (for fine tuning).

Remove will remove the current player.  All information will be deleted.

Remove Last Point will remove the last control point of the current players path.  This is useful if the user added too many points.  The users can add more points by selecting Mode - Append.

Normalize Time will recalculate all time keys for the current player.  It will adjust all keys, so that the current player will run with a constant speed from the beginning to the end of the play.  All previous time adjustments for this player will be lost.

Normalize Angle will recalculate all angle keys for the current player.  It will adjust all keys, so that the current player will look in a direction, which is the average of the direction he is coming from and the direction he is going to.  All previous angle adjustments for this player will be lost.

The Play menu
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The Play menu groups all functions for changing the play information.  They have a global influence.

Edit will open up the player dialog box for the current player.  The user can choose the offense and defense team (out of the Big 10), the start and end time, the start position of the ball, whether the play is a passing game, and whether the game is successful for the offense team.

Usually the start time is zero for a play from the chart book and has a “real” value for a play from a real game (e.g. from a video).
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Center All will center the main area on the whole play.  Every player and every path is visible.

Center Start will center the main area on the start position of every player.

Speed let the user select the animation speed.  The current options are 4, 3, 2, 1, ½, 1/3, ¼.

Video let the user select the input method for a new player.  If Video is checked, Ched will assume the user wants to digitize a video and it will open up the control point dialog for each new position.  The user has to specify the time, position, angle, pose, and has ball for every point.  If Video is unchecked, Ched will assume the user wants to enter a play from a playbook.  The user can just specify all the positions and Ched will call Normalize Time and Normalize Angle at the end.

Upside Down is used for training of the defense team.  The play will be presented upside down (turned 180°).

Inverse Y will change the output of the y position in the status field to the complement to 100 yards.  So, instead of showing the player is on the 80 yard line, it will show 20 yards are left.

Relative is an experimental feature for time key changes.  It should not be used.

Polygon specifies, whether the path is shown.

Label specifies, whether the control points have the number label.

Foot Grid specifies, whether Ched shows a Foot grid (a pixel for every foot).

Yard Grid specifies, whether Ched shows a Yard grid (a pixel for every yard)

Field specifies, whether Ched shows the football field.

The CAVE menu
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The CAVE menu groups all functions for the CAVE remote control.  This menu should only be used, if the system is connected to a CAVE and certain other steps have been done before (ask your local technician).  All functions do not work until the user starts the CAVE (menu point Start CAVE).

Reset Navigation will bring the CAVE user back to the current navigation point (center point of the play or to the attached player).

Fly let the user select, whether the CAVE user can fly or whether the CAVE user is bound to the ground.

Lock Navigation let the user select, whether the CAVE user can navigate or whether the CAVE navigation is locked.

Transparency will change the transparency value of the current player (the attached player).  The current options are 0%, 20%, 40%, 60%, 80%, or 100%.

Ball Marker let the user select, whether the ball has a marker for better visibility (a big sphere).

VP Mode let the user select, how the CAVE user is attached to a football player.  The options are:

· Mode 0 (not attached, just go to the player)

· Mode 1 (follow the player, but do not align the stadium)

· Mode 2 (follow the player and align the stadium)

· Mode 3 (follow the player in the helmet)

VP Player shows a list of all the players.  The user can attach the CAVE user to a football player.

VP Stadium let the user select fixed viewpoints in the stadium.  The current list is: 50-yard line, tunnel, press box, trainer, and overview.

Sound Start and Sound Stop let the user start or stop certain sound events.  The current list is: Background, Fanfare, Victors, and Let’s Go Blue.

Load Play will upload the current play to the CAVE.  Ched will start the simulation and AI upfront.  This upload takes a long time and the CAVE will freeze for a while.

Update CAVE will upload to current play to the CAVE.  Ched will start the simulation and AI upfront.  This step is much faster than Load Play, but it depends on a couple of things.  All players have to be the same to the previous uploaded play (same number, same order, and the same numbers on the back of the football players).  The CAVE can crash, if the new play is too different.

Stadium let the users select the stadium.  The current list is: Michigan new, Michigan old, field, grid.  It is more an experimental feature.  There is still a memory leak (the system can crash).

Start CAVE connects Ched to the CAVE.

The Help menu
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The Help submenu has only two functions.

Help is not implemented yet.  That’s why the menu point is grayed out.

About will open up an about dialog.  It can be closed by clicking on OK
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The Animation control
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The animation control is used for the time navigation.  The first button sets the current time to the start time and the fifth button to the end time.  The second button starts the animation backwards and the fourth button starts it forward.  The third button will pause or resume the animation.  The sixth button is a shortcut to the File – Open function

The Status fields
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It shows the current state of Ched.  The first field shows the current mode (see Main Display area for more).  The second field shows the current position of the mouse pointer in the field.  The first number is the x position in yard and feet (zero means the center of the field).  The second number shows the y position in yard and feet (in this case the 50-yard line).  The third field shows the current time in seconds and frames.

The fourth and last field shows the current zoom level (1 means a pixel represents a feet).  The user can currently choose between 1 and 20.

The Main Display area
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This is the biggest and most important area.  The user can do most of the interactions here.  Its behavior depends of the current mode, which is displayed in the first status field.  The user should always be aware of the current mode.  There are four modes:

The Edit mode is the default mode.  The user can select current player for the Player menu by clicking on the path of the player.  The current player is highlighted and all the control points are shown.  The current player will be unselected, if the user clicks in an area where no player is near.

The user can invoke the control point dialog by clicking on a control point.  The uesr can then specify the time, position, the viewing angle, the pose, and whether or not the player has the ball for this control point and the following section.  The AI will override the pose, if the user selects the default pose.
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The user can change the position of a control point by dragging the point.  The mouse pointer will snap to the feet grid by pressing control while dragging.  The color of the section before and after can change.  Blue means everything is okay, orange a football player can run that fast, but only for a short time, and red means no football player can run that fast.  If the user gets a red line, he or she should adjust the time keys.

The Move mode allows the user to pan the current view.  The combination of pan and zoom allows the user to find the best view for certain operations (like fine tuning).

The Add mode will add a new player.  It will open the player dialog box so that the user can choose basic player options (see the Player – Option menu).  After the user clicks on OK, he or she can just click on the position where a new control point should be.  Depending on the Video option a control point dialog will show up.  The user can go back to the Edit mode by selecting Mode – Edit or by entering the last point with a double click.

The Append will add additional control points to the current player every time the user clicks on the field where the new point should be.  It behaves similar to the Add mode, but it will use the current player instead of adding a new one.

The Time Control area
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This area can be used for fine-tuning the time keys and for setting the current time.  It shows a small hash mark for every frame (there are 30 frames in one second) and a bigger hash mark for every second.

The current time can be set by dragging the black marker to the left or right.  The marker will snap to the nearest frame by pressing control while dragging.  The players will be updated in real-time.

Every control point has a small blue marker on the lower area of the time control.  It shows when the player will be at the control point’s position.  The marker will be red, if the user drags a control point in the main display area.  The markers can be dragged to the left or right to change the time key.  The marker will snap to the closest frame by pressing control while dragging.
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